HEC-HMS Guidance
for the Contra Costa County Flood Control
& Water Conservation District
Unit Hydrograph Method

By Mark Boucher

Updated March 6, 2018
Document Version Notes

This document is updated from time to time as the US Army Corps of Engineers (Corps) may update the HEC-HMS modeling program or new discoveries regarding the model are made. Not all graphics are updated and some screen capture graphic from previous HEC-HMS versions are still shown and may not match the current version.

**We have found minor software issues with HEC-HMS Version 4.1 and recommend using HEC-HMS Version 4.2.1.**

Contra Costa County cannot be held responsible for changes in the Corps model that are inconsistent with this guidance document. See disclaimer section for more information.
Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disclaimer</td>
<td>vii</td>
</tr>
<tr>
<td>Document Update Summary</td>
<td>vii</td>
</tr>
<tr>
<td>Abbreviations</td>
<td>viii</td>
</tr>
<tr>
<td>Introduction</td>
<td>1</td>
</tr>
<tr>
<td>Overview</td>
<td>2</td>
</tr>
<tr>
<td>Guidance Document</td>
<td>2</td>
</tr>
<tr>
<td>Template HEC-HMS Model</td>
<td>2</td>
</tr>
<tr>
<td>Building a HEC-HMS Model</td>
<td>3</td>
</tr>
<tr>
<td>Input and Results in DSSVue</td>
<td>3</td>
</tr>
<tr>
<td>Template Model Content</td>
<td>3</td>
</tr>
<tr>
<td>Project Creation</td>
<td>5</td>
</tr>
<tr>
<td>Basin Model Manager</td>
<td>7</td>
</tr>
<tr>
<td>Time Series Manager</td>
<td>7</td>
</tr>
<tr>
<td>Paired Data Manager</td>
<td>8</td>
</tr>
<tr>
<td>Folder View after Creating Components</td>
<td>8</td>
</tr>
<tr>
<td>Data Entry</td>
<td>9</td>
</tr>
<tr>
<td>Paired Data</td>
<td>9</td>
</tr>
<tr>
<td>Basin Model</td>
<td>10</td>
</tr>
<tr>
<td>Basin Units</td>
<td>10</td>
</tr>
<tr>
<td>Subbasin Creation</td>
<td>10</td>
</tr>
<tr>
<td>Subbasin Parameters</td>
<td>11</td>
</tr>
<tr>
<td>Time Series Data</td>
<td>13</td>
</tr>
<tr>
<td>Meteorologic Model</td>
<td>15</td>
</tr>
<tr>
<td>Rainfall Distribution Gage and Depth</td>
<td>16</td>
</tr>
<tr>
<td>Storm Depths from Map and Curves</td>
<td>17</td>
</tr>
<tr>
<td>Storm Depths from Equations</td>
<td>17</td>
</tr>
<tr>
<td>Control Specifications</td>
<td>18</td>
</tr>
<tr>
<td>Time Interval</td>
<td>18</td>
</tr>
<tr>
<td>Depth Area Reduction Factor</td>
<td>19</td>
</tr>
</tbody>
</table>

March 6, 2018
Using Detention Basins in HEC-HMS

Running a HEC-HMS Model

Running Single Simulations

Running Multiple Simulations

Understanding the Results

Viewing Results

Results from the Results Tab

Results from the Basin Model Map

DSS Files

Summary

APPENDIX A. Storm Depth Equations

HYDRO6 Tables

Simplified Tables

Example Storm Depth Calculation

APPENDIX B. Rainfall Distribution Curves

APPENDIX C. Depth Area Reduction Factor (DARF)

APPENDIX D. Lag Time Equation

APPENDIX E. District HEC-HMS Template

HEC-HMS Template

Template Contents

Using the Template

APPENDIX F. HEC-HMS vs HYDRO6

Comparison of HYDRO6 and HEC-HMS Output

Observed Issues with HYDRO6

APPENDIX G. HMS Tips

Save Often

Renaming

Pasting data from Microsoft Excel

Editing Parameters in Tables

Options Tab – Subbasin

Open Last Project

Close Simulation Run Progress Window
Viewing Results.................................................................................................................. G-4
Message Tone Options........................................................................................................ G-5
Copying Graphics to Reports.............................................................................................. G-5
HEC User Support................................................................................................................. G-5
Time Windows....................................................................................................................... G-5
Total Override....................................................................................................................... G-5
HEC-HMS v3.4 and v3.5 Issues (updated 8/16/11)................................................................. G-5

APPENDIX H. Using DSS files and HEC-DSSVue ............................................................... H-1

APPENDIX I. Running HEC-HMS in Batch Mode from the DOS Window............................ I-1

Batch File .................................................................................................................................. I-1
Text File ..................................................................................................................................... I-1

APPENDIX J. HEC-HMS updates: Responding to changes in data requirements for Soil Moisture Accounting method ......................................................................................... J-1

APPENDIX K. Review of Loss Method .................................................................................. K-1

Model Used .............................................................................................................................. K-1
Methods .................................................................................................................................... K-1

Soil Moisture Accounting Loss Method................................................................................ K-2
Deficit and Constant Loss Method .......................................................................................... K-3
Initial and Constant Loss Method............................................................................................ K-3
List of Tables

Table A-1  MR1 Constants for Storm Rainfall Depths - HYDRO6 ........................................... A-1
Table A-2  MR2 Constants for Storm Rainfall Depths - HYDRO6 ........................................... A-1
Table A-1  C1 Constants for Storm Rainfall Depths - Simplified ........................................... A-2
Table A-2  C2 Constants for Storm Rainfall Depths - Simplified ........................................... A-2
Table B-1  Rainfall Distribution Curves ................................................................................. B-2
Table C-1: Areal Rainfall Reduction Factor Table .................................................................. C-2

List of Figures

Figure 1  HEC-HMS Project Creation Example ....................................................................... 6
Figure C-1  Areal Rainfall Reduction Factor Standard ......................................................... C-3
Figure F-1  Comparison of HYDRO6 and HEC-HMS Output ........................................... F-1
Figure F-2  Comparison of HYDRO6 and HEC-HMS Peaks ............................................. F-2
**Disclaimer**

The instructions and tips provided in this document should not be understood to be official instructions or training for becoming proficient with, or an expert in, the District’s methods or the use of HEC-HMS. The District has not written this document to ensure that the reader and user of this document’s instructions in District’s methods or HEC-HMS become competent in their use.

The Template Model (Template) referred to in this document was created by the District for use with the HEC-HMS modeling program. It was created for your convenience. The District has taken care to make it useful and accurate. However, it is possible the District has entered data into the Template incorrectly or has set, or chosen, settings or options incorrectly. Therefore, the District does not warrant or guarantee the information or data in this document or the Template to be correct, accurate, and complete, or without defect or error.

The reader and user of this document and/or the Template should use his or her own judgment to review and correct the instructions and the Template including model inputs, settings, and results if and where needed. It is the responsibility of the engineer using the Template to confirm that the data in the model is accurate and without error as received and as modified.

The user of the Template is also directed to the disclaimer in the “Description” field of the Template and the “Terms of Conditions of use for HEC-HMS” in the U.S. Army Corps of Engineers manuals.

**Document Update Summary**

This document was updated on the date shown on the cover and footer. By quick review, spelling, typing, and grammar errors were corrected. Some of the guidance tips were updated. The document was not thoroughly reviewed.

The current preferred version of HEC-HMS is version v4.2.1. It is stable in the Windows 7 operating system. The screen shots and directions provided herein are based on HEC-HMS v3.3 and later. The basic functionality of HEC-HMS in the various version is the same, however, some the graphical user interface (GUI) for v4.2.1 and higher is different from v3.3 and later and the screen shots provided herein should still provide enough continuity with v4.2.1 that they are applicable. We will likely update this document in the future to address important changes in HEC-HMS version.
Abbreviations

The following are key abbreviations used in this document:

- **HEC** US Army Corps of Engineers Hydraulic Engineering Center
- **HEC-HMS or HMS** HEC Hydrologic Modeling System computer software developed by HEC
- **District** Contra Costa County Flood Control and Water Conservation district
- **HEC-DSS or DSS** Data Storage System
- **DSS-Vue** Hydrologic Engineering Center Data Storage System Viewer computer software developed by HEC

MB:

```
\PW-DATA\grpdata\fldctl\Hydrology\Hydrology Standards\Working Versions to combine all\2018-03-06 HEC-HMS Guidance for CCCo.docx
```
HEC-HMS Guidance
for the Contra Costa County Flood Control
& Water Conservation District
Unit Hydrograph Method

Introduction
For many years the Contra Cost Flood Control and Water Conservation District (District) has used several internally developed programs to perform hydrology calculations. These programs were written in FORTRAN. The District’s HYDRO6 program ran in a DOS mode on the Windows 32-bit platform for input and produced unit hydrographs and flood hydrographs on screen and in an output text file. The District’s HYDRO2 program ran using an input file with unit hydrographs produced by HYDRO6 and/or also hydrographs entered in the input file. HYDRO2 was used for complex watershed models including multiple watersheds and on-line or off-line detention basins. However, these programs were limited to only the District’s method and did not have a Windows graphical users interface.

In the past, anyone wanting a hydrograph for use in a flood study had to request the hydrograph from District staff. They then could use the District provided unit and storm hydrographs in other programs (HEC-1, HEC-HMS, Mouse, MIKE11, or other hydrology software) to perform more complex watershed hydrology analyses.

In an effort to find a replacement for its proprietary programs, District staff has verified most of the standard data needed for HEC-HMS modeling. These include rainfall distribution curves, the S-curve (a.k.a. percentage curve) used for the unit hydrograph method, and the lag equation. Other standards staff are still verifying are watershed N-values, infiltration rates, and methods used in measuring or calculating specific parameters for the hydrology calculations. The District’s Hydrology Section will continue to review these standards and provide guidance to the public. With limits in man-power and budget, this process has become a long term process.

Comparisons of the HEC-HMS model and HYDRO6 have revealed some subtle differences between the two models and some minor problems with HYDRO6. APPENDIX A presents those differences and problems. The transition to HEC-HMS has addressed those problems.
Overview

Guidance Document
This document describes how to use HEC-HMS to model a watershed and produce the same results one would get from using HYDRO6. The purpose is to be concise and yet complete. This document is not intended to explain all aspects of HEC-HMS or the District’s method. This document also includes guidance on using a Template model put together by the District, tips, and other information that may be helpful to the readers who are not familiar with HEC-HMS.

Template HEC-HMS Model
The HMS Template Model is available for download from the District’s website¹ and has the District’s standard rainfall distribution curves, and S-curve in it as well as a single watershed set up to run. In essence, the data for the standards curves mentioned in this guidance document are included in the Template model and do not have to be manually input if you start a project with the Template model.

The District created this Template model for several purposes:

1. To simplify the building of an HEC-HMS model for the District’s methods.
2. To provide a clear starting point for modelers with accurate standard curves.
3. Reduce the time to review the HEC-HMS models by assuring the standard curves were input correctly.

We recommend that you download and open the Template model and follow it as you go through this guidance document. The Template model will not match the figures in this document perfectly, but using them together should increase your understanding of how a HEC-HMS model is put together for using the District’s method.

---

¹ Go to [http://www.contracosta.ca.gov/5745/Documents-and-Standards](http://www.contracosta.ca.gov/5745/Documents-and-Standards) and click on “Hydrograph Standards” in the left sidebar.
Building a HEC-HMS Model

A model in HEC-HMS is made by starting HEC-HMS and creating a new project. The following is a list of steps for setting up an HEC-HMS model.

On the “Components” tab:
- **A Basin Model** is created with subbasins and other elements needed for the model. The subbasin characteristics are entered into the Basin Model.
- **Control Specifications** are created to define the date and time for which the model is to be run. The rainfall time series start and end times (time frame) must fall within the Control Specification time frame.
- **Time Series** data is entered including rainfall patterns and known hydrographs if any.
- **Paired Data** is input to define the S-curve, and if needed, detention basin stage-storage and stage-discharge relationships as well as a storage-discharge relationship.
- **A Meteorologic Model** is set up. This assigns the rainfall time series data and storm rainfall depths to the watersheds in the Basin Model for various storms.

On the “Compute” tab:
- The model runs (simulations) are set up as combinations of Basin Models, Meteorologic Models, and Control Specifications.
- This allows many combinations of different model parts to run various scenario simulations. That is, a Basin Model can be run using several different Meteorologic Models and Control Specifications.

On the “Results” tab:
- The results of each simulation are organized in the Results tab in the same order that the simulations are organized on the Compute tab.
- From the Results tab you can view the results in graphical and tabular form.

**Input and Results in DSSVue**
The results of the HEC-HMS models, as well as the input curves and time series data, are saved in Data Storage System (DSS) files. This makes them easily transportable to other HEC models. The DSS files can be viewed in HEC-HMS, but the user may find it easier to view the data using HEC-DSSVue and from there copied and pasted or exported to other formats such as Excel.

The sections that follow provide more details for building a basic HEC-HMS model with screen and menu shots provided for clarification. HEC-DSSVue guidance is not provided in this document.

**Template Model Content**
The Template model contains all of the basic time series data and paired data related to the District’s standards and was set up to follow naming conventions suggested in this guidance. Though

---


this guidance describes steps to set up a model, you can skip many of these steps by using the Template.
Project Creation

After starting HEC-HMS, choose File/New. In the dialogue box, enter a descriptive name for the HEC-HMS project, select the location for the model’s files, and choose U.S. Customary units. Click “Create”.

After creating the project, the HEC-HMS window (Figure 1) will show a folder with the project name, the description, and the location of the DSS file for the project. The HEC-HMS program stores time series and pared data as well as the model results in the DSS file.

This is a good time to set the defaults for the model. Go to the top HEC-HMS menu bar and click Tools > Program Settings. We like to set the following defaults on the Default tab as follows:

- Unit system: U.S. Customary
- Subbasin Surface: Simple Surface
- Subbasin loss: Initial and Constant
- Subbasin transform: User-Specified S-Graph
- Subbasin baseflow: Recession
- Reach Routing: Muskingum-Cunge
- Subbasin precipitation: Specified Hyetograph

If the defaults are not set, they can be changed at other places in the model. Establishing the defaults early saves time and avoids mistakes.

If you download and use the Template model from the District website, many of these steps can be skipped.

---

4 This is the simplest method to use. You may also use the Soil Moisture Accounting Method and the Deficit and Constant Method. See APPENDIX K. for instructions on each of the methods.
Figure 1  HEC-HMS Project Creation Example
Component Creation

Using the Components menu (see image to right) and the “managers” under it, you must create at least one of each of the following for a model using the District’s method:

- Basin Model,
- Meteorologic Model,
- Control Specifications,
- Time-Series, and
- Paired Data.

Basin Model Manager

Using the Basin Model Manager, create a basin. Name it what you want and enter a description as needed. The Basin Model will contain subbasins (watersheds) and other elements such as reaches, junctions, and detention basins. You will often have more than one Basin Model such as the pre-project and the post-project model. You can copy a Basin Model, so it is helpful to build one of the Basin Models and then copy it and modify the copy to make the other Basin Models.

Do the same with the Meteorologic Model Manager, and Control Specifications Manager. These managers do not have options other than creating and naming components. The components are edited later to add model specific information.

Time Series Manager

Using the Time Series Manager create a time series for a design storm. In the image to the right, a precipitation gage is defined for the 3-hour rainfall distribution curve. The actual data for the curve will be input later. Notice the name we use is “03 h” and not “3 h”. HEC-HMS sorts the components alphanumerically. By including a “0” in front of the “3”, the “03 h” curve will be listed before “06 h” and “12 h” in the list of precipitation gauges. In addition, using the “h” instead of the word “hour” saves typing time and space in table and plot labels later on.
This convention is a District preference. We have learned that this practice of naming the components aids in organization, management, and review of the models.

**Paired Data Manager**

Using the Paired Data Manager create a percent pattern. In the image to the right, we have selected “Percentage Curve” for the S-curve we will input later. The paired data manager is where placeholders are created for stage-storage curves, stage-discharge curves, etc. Any paired data that is not associated with time is entered using this manager.

**Folder View after Creating Components**

In the image to the right, we have expanded the “folders” for the entire HEC-HMS model and exposed all of the components created using the Component Managers.

These are the basic components needed to run a model using the District’s method. Beyond this, you can create more Basin Models (with multiple subbasins, detention basins, junctions, diversions, sinks), Meteorologic Models, Control Specifications, Precipitation Gages and other paired data.

A good practice would be to set up a basic model like this, including the standard rainfall distribution curves and S-curve and save it as a template for future modeling work. This will save time and assure consistency. Later in this document, we present such a Template we have created for use in Contra Costa County.
Data Entry

The data entry order is important in that some elements depend on data from others. For example, for the District method, each subbasin needs the S-curve data for its transformation method and the Meteorologic Models need the precipitation gage data. Below, we describe an order of data entry that inputs data in a logical order to reduce having to go back and forth between model elements and data entry.

Paired Data

Because the Basin Model requires the selection of the S-Curve, you should enter it first. Paired data consists of both X and Y values. The District’s S-curve has 840 X-Y values and is not provided in this document. It is included in the Template model and is also available in electronic format from the District website. Search for a downloadable file under “S-Curve in xls format” at: http://www.cccounty.us/5747/Hydrology-Standards.

By clicking on the S-curve component created earlier, three tabs are shown. The “Manual Entry” option shown for “Data Source” on the Paired Data tab in the image above is correct.

Note: This S-curve data is included in the Template model and can also be obtained in an .xls file online.
The paired data entry forms have **Table** and **Graph** tabs for data entry and graphical review. For the basic model (a model without detention basins, diversion, etc.) the S-curve is the only paired data required for the District’s modeling method. Other paired data include stage-storage and stage-discharge curve for detention basins.

**Basin Model**

You can model many subbasins (watersheds) in a Basin Model. You can create detention basins, define junctions and diversions, join hydrographs at junctions, and use routing methods to estimate the attenuation of flow down creeks. You can perform many other hydrologic tasks. However, at its basic level, the basin model needs at least one subbasin. The example that follows includes only one subbasin.

**Basin Units**

The units used in the modeling should be consistent with your project. We use the U.S. Customary units in Contra Costa County. The units on the subbasin should be checked to make sure they match what you are using in your project.

When you select the basin icon, the lower portion of the window shows basin information. Find the “Unit System” line and select the correct units for your basin using this window. If you set this as the program default as mentioned above, it should already be correct.

**Subbasin Creation**

In the image to the right, we have created a subbasin by clicking on the Subbasin Creation Tool (icon defined above right), clicking in the “Basin Model [Basin 1]” window (map like), entering the name “Pre” and clicking “Create”. In the image, we have expanded the “Basin 1” basin folder and the Pre subbasin folder to reveal other parts of the subbasin element.
Subbasin Parameters

When you click on the subbasin in the folder view, (or on the map using the arrow tool), the lower part of the HEC-HMS window shows tabs related to the subbasin (see image at right).

The first tab is the Subbasin tab. A Description can be entered. You enter the Area under this tab. For the District’s method use the following options:

- Surface Method = Simple Surface
- Loss Method = Initial and Constant (APPENDIX K. discusses other options).
- Transform Method = User-Specified S-Graph
- Baseflow Method = Recession.

When you change these options in the Subbasin tab, the options on the Surface, Loss, Transform, and Baseflow tabs also change. Setting these options as defaults under the Tools>Project Options menu saves time in larger projects that have multiple basins.

Clicking on the Loss tab reveals that the Soil Moisture Accounting method has numerous fields for input. For the District’s method:

- All the fields must be set to “0”, except for two; otherwise, the model will not run.
- Surface Storage = 0.25 inches
- Max Infiltration = the constant infiltration, which varies with land use is input here.

The Surface tab should have Initial Storage=0 and Max Storage=0.25”. (see image to right)

The Loss tab should have all values = 0 except Max Infiltration should be equal to the watershed infiltration rate for the watershed. (see image to right)

The Transform tab is where you choose the S-Graph (aka S-curve) for the Subbasin. The Lag Time is unique to each subbasin. Calculation of the District’s Lag Time is described in APPENDIX D.
The District’s **Baseflow** standard is a constant 5.0 cubic feet per second per square mile (cfs/sq. mi.).

The settings are:

- Initial Type = Discharge Per Area
- Initial Discharge = 5 cfs/sq. mi.
- Recession Constant = 1
- Threshold Type = Threshold Discharge
- Flow = 0 CFS

The **Options** tab is explained in **APPENDIX G**.
Time Series Data

For the District’s method, time series data consists primarily of precipitation data input for the rainfall distribution curves. The Meteorologic Model will provide the option of Total Override that must be set to “yes”. This option causes the total storm rainfall depth entered into the Meteorologic Model to be distributed over time in the same pattern as input in the time series for the precipitation gage.

The image to the right shows the 03 h Precipitation Gage we create earlier and the Time-Series Gage tab visible in the lower window. The District’s method requires:

- Data source = “Manual Entry”
- Units = “Incremental Inches”
- Time interval = (dependent on rainfall distribution curve. See APPENDIX B).

The District’s standard data comes in 15 minute, 30 minute or 2 hour time intervals. The 15-minute time interval is correct for the District’s standard 3-hour storm rainfall distribution we will input to this gage in our example.

After clicking the plus sign next to the time series and selecting the “time window” below the “03 h” icon, you will see other tabs appear. In the Time Window tab, change the start and end date and time for the rainfall data. Use the ddMMYY format as shown.

**IMPORTANT:** The time series time and date must be within the Control Specifications Component time and date you will create later.

The HEC-HMS default is likely different from what was input for Control Specifications or any other time series you may have entered. Change the start date and time to be the same as the modeling period you want to use. Enter an end time so that it is at or beyond the time
of the end of your gage data.

For the 3-hour curve, you can set the time and date as shown in the image on the previous page. (NOTE: When you input data, the text changes to the color blue. They turn black when you save).

The District’s 3-hour rainfall distribution curve is shown at the right. This is put into the Table tab of the “03h” Time-Series Gage. This and other district rainfall distribution curves are provided in APPENDIX B.

The date and time on this tab reflect the Time Window tab settings. The District’s standard rainfall distribution curves are available in its standards document and in electronic format and can be copied and pasted into the HEC-HMS time series tables.

Note that the rainfall input starts at the start of second time interval.

If a gage is used in a model run with a Control Specifications with a different time frame than the gage, HEC-HMS will create a different time window under the Time Series Gage. Though this may clutter the folder view, it does not alter the Precipitation Gage data. Time windows can be deleted using the right click menu options. Be sure that the remaining time windows contain all of the precipitation gage data and make sense as part of your model. The precipitation data can be visually checked via the Graph tab.

---

The precipitation time series data for the 3-, 6-, 12-, 24, and 96-hour storms are included in the Template model.

The rainfall distribution curves are entered into the Template model that is available on the District’s website at http://www.cccounty.us/5746/Hydrograph-Standards. They are also available via http://www.cccounty.us/5747/Hydrology-Standards.
Meteorologic Model

The Meteorologic Model assigns the storm rainfall to the subbasins. For the District’s method, we use it to apply the rainfall pattern and total design storm rainfall amount to the subbasins. Click the Meteorologic Model and look at the tabs in the lower left portion of the HEC-HMS window.

The Meteorologic Model should look like the image to the right (except for the model name):

- Precipitation = Specified Hyetograph
- Evapotranspiration and Snow Melt = None
- Units System = U.S. Customary.

If you are working with only one basin model, you do not need to duplicate the basin model for each design storm. You simply need to create a Meteorologic Model for each design storm. Then use each of them with the same basin model in different simulation runs.

You may have “pre” and “post” conditions models. You would need different basin models for these because the subbasins would have different characteristics.

On the Basins tab, the basins that the Meteorologic Model will apply to should have “Yes” selected by their names. This indicates that this Meteorologic Model can be used with these basins. The reason for this option is that there are times when you would want to prevent the “accidental” use of a Meteorologic Model with a specific Basin Model.

On the Options tab, the Total Override should be set to “Yes”. This tells the Meteorologic Model to replace the precipitation gage total with the storm total (to be entered later). In effect, this makes the precipitation gage a rainfall distribution pattern because it overrides the rainfall depth in the precipitation gage with storm total for the subbasin. If you choose “no” for this option, you would have to scale the precipitation gage data to equal the rainfall depths or each time step. The override = yes option greatly simplifies the modeling effort.
Rainfall Distribution Gage and Depth

If the precipitation gage is already input into the model, you can set the precipitation gage (rainfall distribution pattern) for each subbasin and enter the storm rainfall depths (aka total storm rainfall amount).

To do this, click **Specified Hyetograph** under Meteorologic Model folder and choose the gage you want for each Subbasin. In the example to the right, we choose the 03 h gage and put in the **Total Depth**.

The Total Depth is related to the return period of the storm so this is a good time to rename the Meteorologic Model. In this case, this is a 3-hour, 10-year storm and we renamed the Meteorologic Model to be the “03h 010y” (see Tips on renaming in APPENDIX G. APPENDIX A.).

Keep in mind HEC-HMS will order the elements alphanumerically. The name you give the elements will affect the sort order HEC-HMS puts it in. We used the “010y” for the return period because we might have a 100-year run that we might name “03h 100y” and a 50-year run that we might name “03h 050y”. HEC-HMS will sort these in order as follows:

03h 010y
03h 050y
03h 100y

The District prefers this naming convention and submittals to the District for review should follow it. This speeds up the review time.
Storm Depths from Map and Curves
The District’s Isohyet Map and Duration Frequency Depth (DFD) Curves can be used to get the total depth for entry into the HEC-HMS Meteorologic Models. The Mean Seasonal Precipitation (MSP; aka Mean Annual Precipitation) can be measured at the centroid of small watersheds, but should be averaged over the area of larger watersheds.

To determine the total storm depth you follow the following steps:

1. Find the MSP for the watershed from the Isohyet Map,
2. Choose the DFD sheet for the recurrence interval (aka return period) you are interested in,
3. Enter the DFD graph x-axis (time) at the duration of the design storm,
4. Trace the duration up until you intersect the MSP curve for the watershed. Interpolate if necessary.
5. Trace left to the y-axis and note the depth, which is the storm depth for that duration and recurrence interval.

Storm Depths from Equations
The rainfall depth calculated in the old HYDRO6 FORTRAN program was based on an equation and tables built into the FORTRAN code. The equation and tables have been checked to verify that they closely match the District’s duration-frequency-depth curves. The equations and partial tables from HYDRO6 are provided in APPENDIX A.

The tables in APPENDIX A provide coefficients for standard storm return periods and durations. The 200-, 500-, and 1000-year storms are available, but not included in the appendix. The 9-, 36-, and 48-hour rainfall distribution curves are available, but are not typically used except in special circumstances. Should you need these coefficients, please contact the District.

---

6 The District’s Isohyet Map and DFD curves can be purchased at the Contra Costa County Public Works Department (255 Glacier Drive) or downloaded under the “Hydrology Standards” link http://www.cccounty.us/index.aspx?NID=530
7 Recurrence interval, return period, and storm frequency are all interchangeable terms.
Control Specifications

Control Specifications define the model start and stop time and the time interval. You may need more than one Control Specification depending on the start and stop time of your model. For example, you may need the model to run for six hours for a 3-hour storm or you may need it to run for five days for a 96-hour storm. As you perform you modeling, make sure that the model runs long enough to calculate the values you need for your design. For example, a model run on a larger watershed may need to be run longer to reach the point in time that a detention basin peaks. The End Times in the Template model may stop the modeling before your values peak. You may also be interested in the time a basin takes to drain and so you may need to extend the modeling time frame to see those results.

On the other hand, if the time window is too long, then the output may be excessive and results standard plots may not be conveniently framed over the storm duration.

Warning: If your Control Specifications time frame is less than your rainfall period for your precipitation, the rainfall amount input under the Meteorologic Model will not be distributed over the storm period, but only within the Meteorologic Model time frame. This will result in erroneous rainfall for your model.  

The dates and times must be input in the format shown in the image above. For most design storm modeling runs, the actual date and time do not matter. What is important is that the Control Specifications time window be the same as precipitation data time window. If you are simulating an actual storm, the rain data can be put into the model using the actual rainfall times. In this case the Meteorologic Model will provide the option of Total Override that must be set to “no” and you don’t put in a storm total. The Control Specification would need to have a time frame that matches the actual rainfall data you enter.

Time Interval

The Time Interval is a key element of the model. It determines the length of the time steps in the model. This interval should be reasonably short. We normally do not use a time step longer than the time step of the precipitation data. A 15-minute time step is a standard. Shorter time steps provide more detail on the magnitude and timing of the peak. See APPENDIX F. and the paragraphs on “Observed Issues with HYDRO6” for a discussion that includes time interval and the peak flow.

---

8 We have informed the Corps of Engineers (HEC) about this issue and they may address it in a future version of HEC-HMS.
**Depth Area Reduction Factor**

The Depth Area Reduction Factor (DARF) is also known in other District documents as the Areal Rainfall Reduction Factor (ARRF) or the Area Reduction Factor (ARF). The purpose of the DARF is to reduce the rainfall depth when the watershed being analyzed is large.

The National Weather Service, National Oceanic and Atmospheric Administration (NOAA) has different DARF curves for different storm durations. The District has adopted only one DARF curve for Contra Costa County and applies it to all storms of all durations and frequencies.

The District’s curve and further explanation of the DARF are presented in **APPENDIX C**. The District’s DARF applies only to watersheds over 3 square miles in area.

**Using Detention Basins in HEC-HMS**

Detention basins, or reservoirs, as HEC-HMS calls them, can be modeled in several ways. The most common method used by the District is to model them using the **Elevation-Storage Discharge** method. The curves (paired data) needed for this method are the stage-discharge and stage-storage curves. In HEC-HMS these are called **Elevation-Discharge Functions** (E-D) and **Elevation-Storage Functions** (E-S).

HEC-HMS also requires the **Storage-Discharge Function** (S-D). You can create the Storage-Discharge function using the other two functions. If the elevations in the E-D and E-S functions are the same, the S-D curve is easier to create. You create the curves with the Paired Data Manager and then enter the paired data in the appropriate component.

HEC-HMS also allows the use of outflow structures such as pipes and spillways. The District will accept HEC-HMS models using the outflow structures. The structures in the plans and those in the model must “match” and simplification of the outlet structure will be carefully reviewed.
Running a HEC-HMS Model

If model components have been created and populated with data, a Simulation Run may be created. To create a simulation, click the Compute> Create Simulation Run command from the menu. The dialogue box in the right image will appear. Name the simulation appropriately. For example, if we want to perform the 3-hour 10-year run, we could name the simulation “03h 010y”. This name will be used in the output to differentiate between other runs.

After naming the Simulation Run, click “Next”. The dialogue boxes will ask for the Basin Model, the Meteorologic Model, and the Control Specifications. If you only have one each, keep clicking “Next” and then “Finish” to complete the Simulation Run creation. Otherwise, choose the components you want for the modeling run.

Click the Compute Tab in the folder portion of the HEC-HMS interface and, after expanding the folders, you will find the simulation run. The HEC-HMS interface should look like the one in the image to the right.

The Basin, Meteorologic, and Control Specifications components show up on the tabs below. For a simple simulation, at this point you would be done setting up the run. You can change the Basin and/or Meteorologic Model and Control Specifications from this window.

For a simulation that requires a DARF the District normally reduces the rainfall depth outside HEC-HMS and before it is entered in the Meteorologic Model. However, you can use the Ratio tab and enter the DARF for that purpose. Be careful not to do both.

Running Single Simulations

To run the simulation you click the “Compute Current Run” icon in the toolbar. You can also right click on the simulation run icon (in this example the icon named “03h 010y” on the Compute tab) and select “Compute”.

The programs should respond by opening a window that shows
the progress of the run with a blue bar. Notes will appear in the message window in the lower right of the HMS program window indicating important modeling information including warnings and errors.

When the run is complete (100%), you have to close the run progress window unless you have changed the program settings to close the run automatically. See HEC-HMS tips in APPENDIX G. for how to change the settings.

Running Multiple Simulations
The later versions of HEC-HMS have a Multiple Compute option under the Compute menu. This allows you to select several or all of the simulation runs and have all run without having to select each and run it. This is convenient when running a whole suite of return period and duration design storms.

Understanding the Results
It is important to remember that hydrographs created using models are not “real”. The most accurate flows are measured flows taken at stream gages. However, stream gages are expansive to install and maintain at a level that guarantees good data. Also, many years of recording data and verifying the gage rating curves\(^9\) are required to predict a flow frequency (10-year, 100-year, etc.) with confidence.

It would be a daunting task to measure the flow in every creek where we anticipate a flood control or drainage project. It would be unreasonable to wait and measure those flows for many years before taking action. Because of this, rainfall-runoff models such as HYDRO6 and HEC-HMS are used.

Rainfall-runoff models predict hydrographs and peak flow rates and are normally based on rainfall recorded at rain gages. Rain gages are much more economical to install and maintain than stream gages. To complete the rainfall runoff relationship, we use the few stream gages that do exist to check and calibrate the rainfall runoff model for a few specific storms where both rainfall and stream flow records exist. Once the calibrated relationship is established, we can build standards around the calibration. The result is methods to we can use to calculate design storms.

Therefore, the model results are not “real”, they are design storms. They do represent our best estimate of the magnitude of the flows we can expect from a watershed. The District’s S-curve Unit hydrograph method was developed by the US Army Corps of Engineers (Corps) during their several studies in Contra Costa County. The District adopted the Corps method as its standard after comparing it to other methods including the SCS curve number method. The S-curve method

---

\(^9\) A rating curve is a curve that relates the depth of flow measured to a flow rate in the creek or river. Usually, manual measurements are required to establish, verify, and revise the curve in a natural creek.
produced the magnitude and timing of peak flows that more closely matched those of the stream gage data.

**Viewing Results**
Assuming the simulation has run successfully, you can access the results via the Results tab, from the basin model map, or from the DSS file.
Results from the Results Tab
The results from the Results tab are relatively easy to understand. If the model has run, the results icon matching the run will be colored; otherwise, it will be grayed out. Clicking the results icon will expand it revealing various elements of the results. Clicking on those elements will reveal a table or graph. More than one item can be selected for Preview tab viewing. Simply use the “Ctrl” key while selecting multiple items for viewing. Any graph that appears in the Preview tab below the folder tree can be enlarged by clicking the graph icon in the toolbar. A time series table can also be produced by clicking the Time Series icon in the toolbar.

Results from the Basin Model Map
If you click back to the Components tab and click on the basin, the basin map should appear. If not, click on a component under the basin model name. By right clicking on an icon on the map a menu will come up with one of the options being “View Results”. Please keep in mind that the run you want results for must be the last selected in the Compute tab and results will only be available if you have run the simulation after any changes you have made. You may also choose the simulation from the drop down menu to the left of the circle in the graphic below.

You can also click on the icons to the right of the run icon to get various reports, tables, or graphs of the results for the selected basin item icon (see circled icons in graphic below)
DSS Files
You may open the DSS file created by the model in the project directory and view as the results there. To do this, you must download and install the HEC-DSSVue\(^10\). This free viewer is powerful, but it can be somewhat difficult to learn how to use it. This document is not intended as a training tool for the use of DSSVue. We do however, recommend that you use DSSVue and become familiar with its abilities. It comes with a +300-page manual that details all of its uses and capabilities.

One value of the DSS file is that it compatible with other HEC products. For example, a hydrograph in a HEC-HMS DSS output file can be read by other HEC-HMS models or by an unsteady model in HEC-RAS. This can save time and reduce errors in transferring data between the models.

Summary
This document provides information on how to use the District’s unit hydrograph method in the US Army Corps of Engineer’s HEC-HMS modeling program. It specifically describes how to create each HEC-HMS modeling component needed for using the District’s unit hydrograph method. It also documents some of the District’s standards as they pertain to the District’s unit hydrograph method and provides links to the District’s website where the standards and a HEC-HMS model template can be found. It provides tips the District has learned while implementing its method in HEC-HMS and other useful information. Using this guidance document, a user should be able to create a HEC-HMS model for a project and accurately use the District’s method for creating design storm hydrographs.

---

\(^{10}\) Hydrologic Engineering Center Data Storage System Viewer (HEC-DSSVue) program is available for download without charge at [http://www.hec.usace.army.mil/software/hec-dssvue/](http://www.hec.usace.army.mil/software/hec-dssvue/).
APPENDIX A. Storm Depth Equations

The design rainfall depth is dependent on the desired storm duration and storm frequency. The duration-frequency-depth curves published by the District embody the District’s standard for design rainfall depth. You can purchase these at the Contra Costa County Public Works Department office (255 Glacier Drive) or downloaded from County’s website. The rainfall depth calculated in the HYDRO6 program is based on tables built into the FORTRAN code. These very closely match the Districts duration-frequency-depth curves.

HYDRO6 Tables
The HYDRO6 program uses the following equation and associated tables in calculating the storm rainfall depth:

\[
D = \left( \frac{MR1}{100} \right) - (10 - MSP) \times \frac{MR2 - MR1}{2500}
\]

Where:

- \( D \) = storm rainfall depth (inches)
- \( MSP \) = mean seasonal precipitation depth (inches) from the District Isohyet map. The value of MSP should be within the range of 10 and 35 inches/year.
- \( MR1 \) = constant for storm duration and frequency from Table A-1
- \( MR2 \) = constant for storm duration and frequency Table A-2

![Table A-1: MR1 Constants for Storm Rainfall Depths - HYDRO6](image)

<table>
<thead>
<tr>
<th>MR1</th>
<th>3-hour</th>
<th>6-hour</th>
<th>12-hour</th>
<th>24-hour</th>
<th>96-hour</th>
</tr>
</thead>
<tbody>
<tr>
<td>2-year</td>
<td>55</td>
<td>73</td>
<td>97</td>
<td>124</td>
<td>200</td>
</tr>
<tr>
<td>5-Year</td>
<td>81</td>
<td>108</td>
<td>142</td>
<td>186</td>
<td>302</td>
</tr>
<tr>
<td>10-Year</td>
<td>95</td>
<td>128</td>
<td>170</td>
<td>222</td>
<td>366</td>
</tr>
<tr>
<td>25-Year</td>
<td>110</td>
<td>150</td>
<td>200</td>
<td>262</td>
<td>436</td>
</tr>
<tr>
<td>50-Year</td>
<td>128</td>
<td>171</td>
<td>228</td>
<td>300</td>
<td>498</td>
</tr>
<tr>
<td>100-Year</td>
<td>138</td>
<td>188</td>
<td>252</td>
<td>332</td>
<td>552</td>
</tr>
</tbody>
</table>

![Table A-2: MR2 Constants for Storm Rainfall Depths - HYDRO6](image)

<table>
<thead>
<tr>
<th>MR2</th>
<th>3-hour</th>
<th>6-hour</th>
<th>12-hour</th>
<th>24-hour</th>
<th>96-hour</th>
</tr>
</thead>
<tbody>
<tr>
<td>2-year</td>
<td>131</td>
<td>184</td>
<td>257</td>
<td>345</td>
<td>621</td>
</tr>
<tr>
<td>5-Year</td>
<td>190</td>
<td>270</td>
<td>374</td>
<td>512</td>
<td>900</td>
</tr>
<tr>
<td>10-Year</td>
<td>224</td>
<td>318</td>
<td>448</td>
<td>618</td>
<td>1110</td>
</tr>
<tr>
<td>25-Year</td>
<td>262</td>
<td>379</td>
<td>530</td>
<td>733</td>
<td>1300</td>
</tr>
<tr>
<td>50-Year</td>
<td>300</td>
<td>430</td>
<td>606</td>
<td>840</td>
<td>1480</td>
</tr>
<tr>
<td>100-Year</td>
<td>328</td>
<td>468</td>
<td>660</td>
<td>920</td>
<td>1660</td>
</tr>
</tbody>
</table>
Simplified Tables

If we simplify the above equation, we can reduce the number of operations in the equation from six to two and perform the calculations faster.

\[ D = C1 + MSP \times C2 \]

Where:

- \( D \) = storm rainfall depth (inches)
- \( MSP \) = mean seasonal precipitation depth (inches) from the District Isohyet map. (The value of MSP should be within the range of 10 and 35 inches/year.)
- \( C1 \) = constant based on rainfall duration and frequency from Table A-3
  \[ C1 = \frac{MR1}{100} - 10 \times \left( \frac{MR2 - MR1}{250} \right) \]
- \( C2 \) = constant based on rainfall duration and frequency from Table A-4
  \[ C2 = \frac{MR2 - MR1}{250} \]

**Table A-1  C1 Constants for Storm Rainfall Depths - Simplified**

<table>
<thead>
<tr>
<th></th>
<th>3-hour</th>
<th>6-hour</th>
<th>12-hour</th>
<th>24-hour</th>
<th>96-hour</th>
</tr>
</thead>
<tbody>
<tr>
<td>2-year</td>
<td>0.246</td>
<td>0.286</td>
<td>0.330</td>
<td>0.356</td>
<td>0.316</td>
</tr>
<tr>
<td>5-Year</td>
<td>0.374</td>
<td>0.432</td>
<td>0.492</td>
<td>0.556</td>
<td>0.628</td>
</tr>
<tr>
<td>10-Year</td>
<td>0.434</td>
<td>0.520</td>
<td>0.588</td>
<td>0.636</td>
<td>0.684</td>
</tr>
<tr>
<td>25-Year</td>
<td>0.492</td>
<td>0.584</td>
<td>0.680</td>
<td>0.736</td>
<td>0.904</td>
</tr>
<tr>
<td>50-Year</td>
<td>0.592</td>
<td>0.674</td>
<td>0.768</td>
<td>0.840</td>
<td>1.052</td>
</tr>
<tr>
<td>100-Year</td>
<td>0.620</td>
<td>0.760</td>
<td>0.888</td>
<td>0.968</td>
<td>1.088</td>
</tr>
</tbody>
</table>

**Table A-2  C2 Constants for Storm Rainfall Depths - Simplified**

<table>
<thead>
<tr>
<th></th>
<th>3-hour</th>
<th>6-hour</th>
<th>12-hour</th>
<th>24-hour</th>
<th>96-hour</th>
</tr>
</thead>
<tbody>
<tr>
<td>2-year</td>
<td>0.0304</td>
<td>0.0444</td>
<td>0.0640</td>
<td>0.0884</td>
<td>0.1684</td>
</tr>
<tr>
<td>5-Year</td>
<td>0.0436</td>
<td>0.0648</td>
<td>0.0928</td>
<td>0.1304</td>
<td>0.2392</td>
</tr>
<tr>
<td>10-Year</td>
<td>0.0516</td>
<td>0.0760</td>
<td>0.1112</td>
<td>0.1584</td>
<td>0.2976</td>
</tr>
<tr>
<td>25-Year</td>
<td>0.0608</td>
<td>0.0916</td>
<td>0.1320</td>
<td>0.1884</td>
<td>0.3456</td>
</tr>
<tr>
<td>50-Year</td>
<td>0.0688</td>
<td>0.1036</td>
<td>0.1512</td>
<td>0.2160</td>
<td>0.3928</td>
</tr>
<tr>
<td>100-Year</td>
<td>0.0760</td>
<td>0.1120</td>
<td>0.1632</td>
<td>0.2352</td>
<td>0.4432</td>
</tr>
</tbody>
</table>

Use the number of decimal places shown for C1 and C2 to produce the same results as the more complicated equation using MR1 and MR2.
Example Storm Depth Calculation

For a watershed with a mean seasonal precipitation of 18 inches (MSP = 18) we can find the 100-year 12-hour storm depth as follows:

- **MSP** = 18 inches
- **Return Period** = 100-years
- **Duration** = 12-hours

**HYDRO6**

- **MR1** = 252 from Table A-1
- **MR2** = 660 from Table A-2

\[
D = \left(\frac{MR1}{100}\right) \cdot (10 - MSP) \cdot \frac{(MR2 - MR1)}{2500}
\]

\[
D = \left(\frac{252}{100}\right) \cdot (10 - 18) \cdot \frac{(660 - 252)}{2500}
\]

\[
D = 3.83 \text{ inches}
\]

**OR**

**Simplified**

- **C1** = 0.888 from Table A-3
- **C2** = 0.1632 from Table A-4

\[
D = C1 + MSP \cdot C2
\]

\[
D = 0.888 + 18 \cdot 0.1632
\]

\[
D = 3.83 \text{ inches}
\]
APPENDIX B.     Rainfall Distribution Curves

Please note that the time interval for the rainfall distribution curves is not the same for all storm durations. The time interval for each rainfall distribution curve is displayed in the second row of the table. The tabulated numbers are in percentages.
### Table B-1 Rainfall Distribution Curves

<table>
<thead>
<tr>
<th>Duration Interval Index</th>
<th>3-HR</th>
<th>6-HR</th>
<th>12-HR</th>
<th>24-HR</th>
<th>96-H</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>15-MIN</td>
<td>15-MIN</td>
<td>15-MIN</td>
<td>30-MIN</td>
<td>2-HR</td>
</tr>
<tr>
<td>1</td>
<td>3.0</td>
<td>2.1</td>
<td>0.9</td>
<td>0.87</td>
<td>-</td>
</tr>
<tr>
<td>2</td>
<td>2.0</td>
<td>2.5</td>
<td>0.9</td>
<td>0.87</td>
<td>0.1</td>
</tr>
<tr>
<td>3</td>
<td>5.0</td>
<td>3.8</td>
<td>1.0</td>
<td>0.88</td>
<td>0.7</td>
</tr>
<tr>
<td>4</td>
<td>2.8</td>
<td>4.5</td>
<td>1.0</td>
<td>0.88</td>
<td>1.6</td>
</tr>
<tr>
<td>5</td>
<td>8.8</td>
<td>6.0</td>
<td>1.1</td>
<td>0.92</td>
<td>1.4</td>
</tr>
<tr>
<td>6</td>
<td>10.2</td>
<td>3.0</td>
<td>1.1</td>
<td>0.98</td>
<td>3.6</td>
</tr>
<tr>
<td>7</td>
<td>5.5</td>
<td>2.3</td>
<td>1.1</td>
<td>1.07</td>
<td>5.6</td>
</tr>
<tr>
<td>8</td>
<td>7.0</td>
<td>2.5</td>
<td>1.2</td>
<td>1.13</td>
<td>4.1</td>
</tr>
<tr>
<td>9</td>
<td>10.5</td>
<td>4.8</td>
<td>1.2</td>
<td>1.18</td>
<td>2.0</td>
</tr>
<tr>
<td>10</td>
<td>11.0</td>
<td>4.3</td>
<td>1.2</td>
<td>1.22</td>
<td>0.6</td>
</tr>
<tr>
<td>11</td>
<td>27.7</td>
<td>2.6</td>
<td>1.3</td>
<td>1.23</td>
<td>0.4</td>
</tr>
<tr>
<td>12</td>
<td>6.5</td>
<td>2.5</td>
<td>1.5</td>
<td>1.27</td>
<td>-</td>
</tr>
<tr>
<td>13</td>
<td>2.2</td>
<td>1.6</td>
<td>1.41</td>
<td></td>
<td>0.1</td>
</tr>
<tr>
<td>14</td>
<td>2.5</td>
<td>1.6</td>
<td>1.69</td>
<td></td>
<td>0.2</td>
</tr>
<tr>
<td>15</td>
<td>5.0</td>
<td>1.7</td>
<td>1.86</td>
<td></td>
<td>-</td>
</tr>
<tr>
<td>16</td>
<td>7.9</td>
<td>1.7</td>
<td>1.94</td>
<td></td>
<td>-</td>
</tr>
<tr>
<td>17</td>
<td>19.0</td>
<td>1.9</td>
<td>2.50</td>
<td></td>
<td>-</td>
</tr>
<tr>
<td>18</td>
<td>6.3</td>
<td>2.0</td>
<td>3.50</td>
<td></td>
<td>-</td>
</tr>
<tr>
<td>19</td>
<td>4.0</td>
<td>2.3</td>
<td>4.90</td>
<td></td>
<td>-</td>
</tr>
<tr>
<td>20</td>
<td>3.0</td>
<td>3.0</td>
<td>21.20</td>
<td></td>
<td>1.1</td>
</tr>
<tr>
<td>21</td>
<td>2.5</td>
<td>3.2</td>
<td>6.80</td>
<td></td>
<td>0.4</td>
</tr>
<tr>
<td>22</td>
<td>2.4</td>
<td>4.1</td>
<td>4.00</td>
<td></td>
<td>4.7</td>
</tr>
<tr>
<td>23</td>
<td>2.2</td>
<td>4.9</td>
<td>3.25</td>
<td></td>
<td>3.0</td>
</tr>
<tr>
<td>24</td>
<td>2.1</td>
<td>14.6</td>
<td>2.85</td>
<td></td>
<td>3.6</td>
</tr>
<tr>
<td>25</td>
<td>6.1</td>
<td>2.52</td>
<td>2.4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>3.6</td>
<td>2.28</td>
<td>3.6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>27</td>
<td>3.1</td>
<td>2.03</td>
<td>5.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>28</td>
<td>2.8</td>
<td>1.77</td>
<td>4.4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>29</td>
<td>2.6</td>
<td>1.62</td>
<td>4.4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>30</td>
<td>2.1</td>
<td>1.58</td>
<td>4.4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>31</td>
<td>2.0</td>
<td>1.53</td>
<td>3.3</td>
<td></td>
<td></td>
</tr>
<tr>
<td>32</td>
<td>1.8</td>
<td>1.47</td>
<td>4.7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>33</td>
<td>1.7</td>
<td>1.42</td>
<td>13.7</td>
<td></td>
<td></td>
</tr>
<tr>
<td>34</td>
<td>1.7</td>
<td>1.38</td>
<td>3.6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>35</td>
<td>1.6</td>
<td>1.33</td>
<td>4.6</td>
<td></td>
<td></td>
</tr>
<tr>
<td>36</td>
<td>1.6</td>
<td>1.27</td>
<td>4.4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>37</td>
<td>1.3</td>
<td>1.22</td>
<td>3.4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>38</td>
<td>1.2</td>
<td>1.18</td>
<td>1.5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>39</td>
<td>1.2</td>
<td>1.12</td>
<td>0.9</td>
<td></td>
<td></td>
</tr>
<tr>
<td>40</td>
<td>1.2</td>
<td>1.08</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>41</td>
<td>1.2</td>
<td>1.03</td>
<td>0.2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>42</td>
<td>1.1</td>
<td>0.97</td>
<td>1.2</td>
<td></td>
<td></td>
</tr>
<tr>
<td>43</td>
<td>1.1</td>
<td>0.93</td>
<td>1.1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>44</td>
<td>1.1</td>
<td>0.87</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>45</td>
<td>1.0</td>
<td>0.83</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>46</td>
<td>1.0</td>
<td>0.77</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>47</td>
<td>0.9</td>
<td>0.73</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>48</td>
<td>0.9</td>
<td>0.67</td>
<td>-</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Total %</td>
<td>100.0</td>
<td>100.0</td>
<td>100.0</td>
<td>100.0</td>
<td>100.0</td>
</tr>
</tbody>
</table>
APPENDIX C.  Depth Area Reduction Factor (DARF)

The following table is the District’s adopted Depth Area Reduction Factor (DARF) table. The purpose of the DARF is to account for the size of the watershed. A smaller watershed could experience relatively uniform rainfall over its entire area. A larger watershed is less likely to experience uniform rainfall depth over its entire area. Therefore, the DARF decreases as the watershed areas get larger.

The District’s DARF is used only for watersheds larger than 3 square miles. The storm rainfall depth is multiplied by the DARF before the rainfall is distributed over time using the distribution curves.

The depth of rainfall from the District’s DFD graphs is a “point rainfall depth”; that is, the rainfall at a specific point on the map. Applying this depth over the entire watershed gives the desired flow rates. However, if the watershed is large, it is unreasonable to assume that the center of the storm can cover the entire watershed. You could not expect the entire county to experience the 10-year 3-hour storm at the same time.

In the event that several large tributaries are being analyzed, a storm might be “centered” over the primary watershed and its DARF would be high, whereas the other watersheds would have a lower DARF because they are farther away from the main tributary. For example, if a storm is “centered” over downtown Walnut Creek, some rain will likely fall in downtown Concord, but you wouldn’t expect the storm to be large enough to deliver the same depth of rain downtown Concord. As you move away from the center of a storm the rainfall amount diminishes and therefore the average storm depth over the watershed should be reduced.
Table C-1: Areal Rainfall Reduction Factor Table

Interpolate as needed.

<table>
<thead>
<tr>
<th>Area Square Miles</th>
<th>DARF %</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0</td>
<td>100%</td>
</tr>
<tr>
<td>3.0</td>
<td>100%</td>
</tr>
<tr>
<td>5.3</td>
<td>99%</td>
</tr>
<tr>
<td>7.2</td>
<td>98%</td>
</tr>
<tr>
<td>9.1</td>
<td>97%</td>
</tr>
<tr>
<td>11.4</td>
<td>96%</td>
</tr>
<tr>
<td>14.0</td>
<td>95%</td>
</tr>
<tr>
<td>16.8</td>
<td>94%</td>
</tr>
<tr>
<td>20.5</td>
<td>93%</td>
</tr>
<tr>
<td>24.5</td>
<td>92%</td>
</tr>
<tr>
<td>29.3</td>
<td>91%</td>
</tr>
<tr>
<td>35.0</td>
<td>90%</td>
</tr>
<tr>
<td>41.0</td>
<td>89%</td>
</tr>
<tr>
<td>48.5</td>
<td>88%</td>
</tr>
<tr>
<td>57.0</td>
<td>87%</td>
</tr>
<tr>
<td>66.5</td>
<td>86%</td>
</tr>
<tr>
<td>78.0</td>
<td>85%</td>
</tr>
<tr>
<td>91.0</td>
<td>84%</td>
</tr>
<tr>
<td>106.0</td>
<td>83%</td>
</tr>
<tr>
<td>123.0</td>
<td>82%</td>
</tr>
<tr>
<td>142.0</td>
<td>81%</td>
</tr>
<tr>
<td>163.0</td>
<td>80%</td>
</tr>
<tr>
<td>184.0</td>
<td>79%</td>
</tr>
<tr>
<td>205.0</td>
<td>78%</td>
</tr>
<tr>
<td>226.0</td>
<td>77%</td>
</tr>
<tr>
<td>247.0</td>
<td>76%</td>
</tr>
<tr>
<td>268.0</td>
<td>75%</td>
</tr>
<tr>
<td>289.0</td>
<td>74%</td>
</tr>
<tr>
<td>310.0</td>
<td>73%</td>
</tr>
<tr>
<td>331.0</td>
<td>72%</td>
</tr>
</tbody>
</table>
Figure C-1  Areal Rainfall Reduction Factor Standard
APPENDIX D.  

Lag Time Equation

The Corps used the April 1958 storm rainfall records and flood hydrograph recorded at the USGS San Ramon Creek at San Ramon gage to derive the unit hydrograph for that un-urbanized watershed. An equation for lag time ($T_{lag}$) and one for the time-rate of change of runoff were also developed for the construction of synthetic unit hydrograph for an un-urbanized watershed. The lag equation used here is very similar to the Snyder Method\textsuperscript{11}, but was customized by the Corps. This customization introduced the “N” values and related the effect of development on the lag time. The lag time (in hours) is expressed by the following equation:

$$T_{lag} = \text{Lag time} = 24 \times N \times \left(\frac{L \cdot L_{ca}}{S^{0.5}}\right)^{0.38}$$

Where:

- $T_{lag}$ = Elapsed time from the beginning of an assumed continuous series of unit effective rainfalls over and area to the instant at which the rate of the resulting run-off at the area concentration point equals 50 percent of the maximum (ultimate) rate of the resulting run-off at that point. This therefore corresponds to the Time = 100% and volume = 50%
- $L$ = length of the main drainage path (miles)
- $L_{ca}$ = length along the drainage path from a point opposite\textsuperscript{12} the centroid of the watershed to the outlet point (miles)
- $S$ = overall slope of the main watercourse (feet/mile),
- $N$ = weighted watershed Manning coefficient (dimensionless)

The parameters used in the $T_{lag}$ equation are explained in the HYDRO6 input requirements on the District’s website under “Hydrology Requests” at \texttt{http://www.cccounty.us/index.aspx?nid=893}.


\textsuperscript{12} Opposite – This term was used by Franklin F. Snyder in his 1938 report. It has been interpreted to mean a point on the main watercourse or channel determined by the perpendicular projection of the centroid to the main watercourse or channel.
APPENDIX E.  District HEC-HMS Template

HEC-HMS Template
The District has created an HEC-HMS model for the Contra Costa County method as a Template Model (Template). The purpose is to decrease the time involved in creating a model using the District method. The Template was created and made available for the convenience of those using the District’s method and the users are directed to the Disclaimer at the front of this document.

Template Contents
The Template contains the following:

1. One basin that has one subbasin.
2. Pre-named Meteorological Models
3. Control Specifications that match the time windows of the time series data.
4. Time series precipitation gages (3-, 6-, 12, 24-, and 96-hour) per the District’s standard rainfall distribution curves.
5. The Walnut Creek Mountain S-curve as paired data
6. Pre-named Simulation Runs
7. U.S. Customary Units

Using the Template

The location of this link may change as we have not settled on the best location on the website for this link and other standards.

When you have the file, do the following:

1. Right click on the link and save the file to your computer or server.
2. Unzip it in a directory of your choice.
3. Start HEC-HMS and open the “.hms” file from the project directory.
4. Use the File/Rename function to rename the model. This seems to work better than the Save As function in that there the model does not freeze up and the “.run” file and DSS file problems do not crop up. Delete any files in the new directory having the old project name.

OR

5. Use the File/Save As function to save the model under a different name. We have had problems with the Save As function and have reported them to HEC. These “bugs” are not difficult to work around. They are:
a. **ERRORS DURING “SAVE AS”:** For some reason, District staff has problems with HEC-HMS when using the Save As function. We do not know if this is because of our operating system or inherent in the latest HEC-HMS version. The following error is presented by HEC-HMS after using Save As and then it becomes unresponsive:

   **ERROR 10000:** Unknown exception or error; restart HEC-HMS to continue working. Contact HEC for assistance.

   **WORK AROUND:** A remedy to this error is to force HEC-HMS to close and restart it. We use the Windows Task Manager, find the HEC-HMS.exe image name under the **Process** tab, and click “End Process”. Otherwise, the Save As function appears to work in that it does correctly saves the project under the new project name. The only problem remaining during the Save As process is discussed below.

b. **PROBLEM WITH SAVE AS:** The Save As function will create a new directory with the same files as the "parent" project, but using the new project name. However, the newly created project run results go into a DSS file in the new project folder that has the name of the "parent" HEC-HMS project. The new project DSS is there, but the results go to the other folder.

   **WORK AROUND #1:**
   
   i. Carefully edit the ".run" file in your new directory using Notepad.
   ii. Use the Replace function in Notepad to replace the old DSS filename with the new DSS filename for each run in the file.
   iii. Delete any files in the new directory having the old project name.
   iv. Check that the old DSS file is no longer used by your model by running a simulation and checking the project directory to see if it contains a DSS file with the old project name.

   **WORK AROUND #2:**
   
   i. When on the Compute tab and when you click on a simulation run icon, the Simulation tab has several fields. One of the fields is the “DSS File” Field.
   ii. We have found that in HEC-HMS v3.5 when edit the file name in the “DSS File” field and save the HEC-HMS model, the ".run" file is modified so that the output goes to the correct location.
   iii. You can find the project DSS path when you click the top folder on the Components tab. You can copy and paste this path to the simulation runs.

6. Rename the basin model and subbasin to appropriate names for your project.
7. Create more subbasins, if needed. You can copy the one in the Template using the copy option on the right click menu. The settings of the Template subbasin will be preserved so you only have to change the data.
8. Calculate the watershed parameters (Area, Infiltration Rate, N-value, L, Lca, Delta H, etc.) for the subbasins and from them calculate the Tlag.

9. Enter the watershed parameters and calculated parameters into the appropriate subbasins in the model.

10. Calculate the storm depths for your design storms and add them to the Meteorologic Models for each subbasin and choose the appropriate gage for the subbasin.

To use the simulation runs, click on them and change the basin model, Meteorologic Model, and Control Specifications. You can also copy them; rename them to better describe what the runs are for. The Meteorologic Models already assigned to them should be appropriate.
HYDRO6 was developed specifically to produce hydrographs for Contra Costa County. HYDRO6 has proven reliable and effective for many years for flood control purposes. The methods it uses are sound.

With the exception of an added option to route a hydrograph using the Tatum method at the end of a run, HYDRO6 has limited abilities compared to HEC-1 and HEC-HMS.

**Comparison of HYDRO6 and HEC-HMS Output**

An example of how well HEC-HMS can match HYDRO6 is shown in Figure F-1. This is for a 2.21 square mile (sq. mi) watershed. HEC-HMS will calculate the residual, which is the difference between the modeled results and “observed” data. In this case, the observed flow is the HYDRO6 output. The residual plot from HEC-HMS is shown in Figure F-1. The residual at the peak flow is just over 1 cfs, which is very minimal compared to the peak 800+ cfs.

**Figure F-1  Comparison of HYDRO6 and HEC-HMS Output**
Observed Issues with HYDRO6

We have observed a few minor issues with the HYDRO6 program:

1. For small design storms of 2-year in frequency when there are high infiltration rates, the peak flow output at the bottom of hydrograph is set equal to the model time step. That is, when the model is run for 15 minute time steps, even though there is no effective runoff due to the low storm depth and high infiltration rate, the peak flow calculated is printed as equal to 15 cfs. If the time step is changed to 5 minutes, the peak flow is printed as equal to 5 cfs.

2. HYDRO 6 calculates the peak flow between modeled data points using the highest 4 flow rates and fitting them to a parabolic curve. On very rare occasions, the HYDRO6 will calculate the peak flow lower than the flows on the hydrograph. When comparing the peak flow value and time with HEC-HMS output, it appears that both peak flow value and time are not well estimated using parabolic curve fitting. The graph Figure F-2 is an example of this issue.

In Figure F-2, the black dashed lines are the 10-year and 25-year 15 minute hydrographs from HYDRO6. The triangles are the peak flows calculated by HYDRO6 placed in time as HYDRO6 produced them. The solid colored lines are hydrographs from HEC-HMS using the same watershed and storm parameters, but running the model with a 5-minute time step. This clearly shows at potential problem with the peak flows estimated by HYDRO6. They are likely lower than they should be.

Figure F-2 Comparison of HYDRO6 and HEC-HMS Peaks
APPENDIX G.  

HMS Tips

The following tips apply to different section in the main text of this document, but were grouped here for simplicity.

Save Often
We have found that HEC-HMS v 3.3 is not entirely stable. Some features stop working or the program freezes up and the program needs to be closed and restarted. It may occasionally crash. HEC-HMS 4.2.1 is more stable, but we have seen some error messages asking the user to close and restart the program.

The Corps is continually modifying and upgrading HEC-HMS. We assume that these problems will diminish as newer versions are released. The Corps normally publishes the upgrades as complete software updates, not patches, and there is no public notification list for updates that that we are aware of. You can report a bug in HEC-HMS via an email address on their web site at http://www.hec.usace.army.mil/software/hec-hms/bugreport.html.

Renaming
It is usually helpful to be able to rename the components after creating them. This can be done by clicking twice on the name in the folder view. There is a long pause before the program reacts, but when it does you will see a text “box” appear around the highlighted text where you can edit the name of the component. You can also activate the renaming by right clicking on the component and choosing “rename” from the menu or by pressing F2. HEC-HMS will occasionally not allow renaming of components. One solution to this problem is to close the program and try renaming after opening the project again.

Pasting data from Microsoft Excel
When pasting data from Microsoft Excel to HEC-HMS fields, Excel data must be in Excel “General” or “Number” format. If is in any other format, the numbers will appear when pasted, but when you save the project, the numbers will likely disappear. This happens for all cases of copying from Excel to HEC-HMS. It helps to test that the pasted values will stay by saving the model before clicking out of the table or menu the data is pasted to.
Editing Parameters in Tables
If there are several subbasins in your model, an easy way to edit the parameters to use the Parameters menu. This brings up a list of all the several parameters that you can see in table format. Set the “Show Elements” selection box to “All Elements” to see all of them at once. The values can copied from the list or from a spreadsheet and pasted in.

Options Tab – Subbasin
The Options tab appears when selecting a subbasin is used to bring observed data into the model for comparison or calibration purposes.

For example, if you have hydrograph you want to compare the HEC-HMS results to, you can input it as time series data and then pull it up under the Observed Flow option shown in the image to the right. When you plot the model results for this subbasin, the observed flow will plot along with it. The Results tab will also provide more information such as “Residual Flow” (the difference between the observed and modeled hydrographs).

If you have a target peak flow that you are trying to mitigate to, you can type that flow rate into the Ref Flow field and it will plot as a horizontal line on your results plot.

Open Last Project
Under the Tools>Program Settings General tab, you can tell HEC-HMS to open that last project on startup.

Close Simulation Run Progress Window
Under the Tools>Program Settings General tab, you can set the program settings so that the progress window automatically closes (see image below).

Viewing Results
Under the Tools>Program Settings menu, you can set the “Results” settings to have the program “Display results outside desktop”. This causes the results windows to pop up outside of the HEC-HMS window and so provides more room for reviewing results.
Message Tone Options
Under the **Tools>Program Settings** menu, you can change the “Messages” settings to reduce the tones the program makes when it displays Notes, Warnings and Errors.

Copying Graphics to Reports
In the Windows® operating system, the “Alt-Print Screen” key stroke copies the active window (not the entire screen) to the clipboard for pasting into a report. This is useful when trying to communicate model inputs or results in a report.

HEC User Support
Users of HEC software ask questions and share ideas through a HEC-USERS listserv. For subscription information or if you have any question about the HEC-USERS list, write to the list owners at the following address: [HEC-USERS-request@LISTSERV.UOGUELPH.COM](mailto:HEC-USERS-request@LISTSERV.UOGUELPH.COM)

Time Windows
HEC-HMS adds “time windows” when the data is used for a Control Spec. If, for example you run a model with a 3-hour storm for 24-hours to see how long a detention basin takes to drain, a 12-hour time window is created for the 3-hour precipitation gage. You can delete it, but it will come back if you re-run the 12-hour model. Having blank cells in the precipitation data will produce messages or warnings during the simulation run, but will not cause computational errors.

Total Override
The rain gage is used in conjunction with the Meteorologic Model. The Meteorologic Model has an option called “total override”. When you turn this on, a rainfall depth is put into the Meteorologic Model and the model uses the rain gage as the pattern for the rainfall. We typically refer to this as a “rainfall distribution curve”.

HEC-HMS v3.4 and v3.5 Issues (updated 8/16/11)
District staff has had some issues with HEC-HMS version 3.4 and 3.5 prior to upgrading to Windows 7. These versions both worked for a short time in the previous version of the Windows operation system and then the program crashed. When trying to start it again the program would crash and display the error message to the right.

District staff reported this error to the HEC staff in Davis, CA and there are ongoing discussions to understand why we get this error and possible solutions. HEC staff has suggested that there is a conflict with a printer driver installed on District staff’s machine that is causing this.

We tried uninstalling all HEC-HMS versions and all Java versions and then reinstalling them. So far, none of these efforts has solved the problem.

We have not found the cause of the error. Since Windows 7 is becoming more commonly used, we do not intend to try to find a work around to this problem.
APPENDIX H. Using DSS files and HEC-DSSVue

The DSS file for the project includes the GAGE and TABLE data that the model uses. The main GAGE data is the rainfall distribution curves and the TABLE data is the “percent” curve or “S-curve” data. Other data that is stored as GAGE data includes observed flow, manually input hydrographs and rain data. The TABLE data includes paired data used for detention basin curve. You can see the other types of data stored there from within HMS under the Components menu and browsing through Time-Series Data Manager and Paired Data Manager.

The RUN data in the DSS file is where the output from HMS is stored. For the RUN data, the text after the “RUN” tag is the Simulation Run name.

The DSS file location is shown in HEC-DSS in two locations. The Output DSS file is shown in a field when you click on the upper most folder in the Component tab. When you click on a simulation in the Compute tab, you will see a field with a DSS file field.

If you look at the simulations you might see that the DSS file location is different for each run. It could be that the default is to make the DSS file for each run separate. FCD staff likes to make DSS file for each run the same. If they are all the same then using the DSS file to view and use the output data is simpler. Also, if the output data is in the same DSS file, saving the project data or sharing the project data is simpler. Maybe there is an advantage to keeping them separate, but we have not understood that yet.

You can use the interface to set the DSS files to the same file for the project and the runs. You select and copy the file path from the field in the Component tab project folder, and then go to the simulations you are using and paste the path to the Output DSS file path field(s).

You can also edit the DSS file path in a text file. Close the HMS program and then open the .run in the project folder in a text editor. In the editor you can search for the DSS file names. In a text editor you can quickly see if they are all the same or not and change them. This can be an
easier method than using the HMS interface. The .run file is a simple text file; there is nothing magical about it. If you know Excel, you can paste the text into Excel and use to manipulate the text and then copy and paste the text back into the text editor.

It is good to clean up the DSS file. Using HEC-DSSVue\(^{13}\) open the project DSS file, sort by Part F (just click the column header), and carefully delete everything except the GAGE (top rows) and TABLE (bottom rows). This cleans out any leftover or random output. When you run the HMS model the outputs should be re-added to this file. Then the DSSVue tools can be used to plot or view the data in tables. Both the graphs and tables can be copied and pasted into other documents and spreadsheets.

It is also go to delete the extra DSS files from the project folder. Go to the project folder and delete DSS files that are not named after the project, but after the runs. If you have DSSVue installed, you can double click the DSS files and see that they are empty or only contain RUN entries. If they contain GAGE or TABLE entries you need to investigate why those entries are there before deleting the file. Deleting files with GAGE and TABLE data may remove that data from your model. Another practice would be to move the DSS files you want to delete to a subfolder. Then open and run the HMS model. If the model loads and runs successfully, you can delete the subfolder the DSS files are in.

\(^{13}\) Hydrologic Engineering Center Data Storage System Viewer (HEC-DSSVue) program is available for download without charge at [http://www.hec.usace.army.mil/software/hec-dssvue/](http://www.hec.usace.army.mil/software/hec-dssvue/).
APPENDIX I. Running HEC-HMS in Batch Mode from the DOS Window

There may be times when a model has several Simulation Runs and the user wants to run them all after a modification of the model. This can be somewhat tedious, though not too bothersome. There is a way to run several Simulation Runs at a time. Those with a little computer suaveness may find this interesting and convenient.

This operation requires two files in the root directory of the C: drive.

**Batch File**

Create a file with the extension “bat”. For example, use Notepad to create a new file. Save it under c:\HMSbatch.bat. Type the following lines in that file.

```
cd C:\Program Files\HEC\HEC-HMS\3.3
hec-hms -s c:\HMSbatch.txt
Pause
```

The “Pause” command at the end simply causes the MS DOS window to stay open. This allows confirmation that the bat file has run and is finished. Otherwise, the window will simply close and you will not know if the processed succeeded or failed.

**Text File**

Next, create another file using Notepad that has a file name that is that same as that in the second line of the bat file. For example, the file that goes along with the above bat file would be named HEC-HMSBatch.txt. It should contain the text as follows:
The first line is optional and can be used as a comment line for the run. The “*” at the end makes it a non-executable comment line. The second line opens the project. Take care to be sure the quotations are consistent. The command is:

    OpenProject("project name", "Project Directory")

The compute command is:

    Compute("simulation run name")

and must be repeated for each simulation run you want to be performed.

The ending comments are “Save” and “Exit(1)” as shown above.

To run the batch file, in Windows Explorer either double click the bat file icon or right click and choose “Open” off the menu.

When the bat file is run, the MS DOS window opens and echoes the first two lines in the bat file. If several long simulations are being run, the user can check to see that the process is actually running by opening the project directory and viewing the details of the file (file size, file data and time, etc.). The size of the “.dss” file, the “.out” file, and other files should change when the Windows Explorer view is refreshed (Choose View>Refresh). This may periodically happen automatically, or the user can press “F5” to manually update the view. The change in size confirms that the model is running.

There is issue with running the model in this batch mode. When run in batch mode, the icons in the “Results” tab in HEC-HMS will not be updated to reflect that the simulations ran. However, the DSS file will reflect the results of the runs.
APPENDIX J.  HEC-HMS updates: Responding to changes in data requirements for Soil Moisture Accounting method

HEC has once again updated the Soil Moisture Accounting (SMA) Method data requirements. To make sure we are applying them correctly so they reflect the HYDRO6 model we took a previously run HYDRO6 model output and duplicated the input using the method put forth in this document. The HYDRO6 model input/output is printed below.

Below are screen shot from a HEC-HMS model that was run in an attempt to duplicate the hydrograph above. The screen shots are for each of the tabs for the Subbasin with the results table and plot at the end of the series. This demonstrates that the adaption to the model input requirements results in hydrographs very close, but slightly less than those from HYDRO6.
HMS Guidance for Contra Costa County

Basin Name: Baxter Creek Watersheds
Element Name: ZTest1

- Description:
- Downstream: --None--
- Area (M2): 2.128
- Latitude Degrees:
- Latitude Minutes:
- Latitude Seconds:
- Longitude Degrees:
- Longitude Minutes:
- Longitude Seconds:
- Canopy Method: Simple Canopy
- Surface Method: Simple Surface
- Loss Method: Soil Moisture Accounting
- Transform Method: User-Specified S-Graph
- Baseflow Method: Recession

Initial Storage (%): 0
Max Storage (IN): 0
Crop Coefficient: 1.0
Uptake Method: Tension Reduction
### Time-Series Results for Subbasin "ZTest1"

**Project:** Baxter Creek HMS  
**Simulation Run:** 100y 03h  
**Subbasin:** ZTest1

**Start of Run:** 01Jan2006, 00:15  
**End of Run:** 01Jan2006, 10:00  
**Compute Time:** 20Nov2013, 10:50:30  
**Basin Model:** Baxter Creek Watersheds  
**Meteorologic Model:** 100y 03h  
**Control Specifications:** 01-day

<table>
<thead>
<tr>
<th>Date</th>
<th>Time</th>
<th>Total Flow (CFS)</th>
<th>Obs Flow (CFS)</th>
<th>Precip (IN)</th>
<th>Loss (IN)</th>
</tr>
</thead>
<tbody>
<tr>
<td>01Jan2006</td>
<td>00:15</td>
<td>10.6</td>
<td>11.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>01Jan2006</td>
<td>00:30</td>
<td>10.6</td>
<td>11.0</td>
<td>0.06</td>
<td>0.06</td>
</tr>
<tr>
<td>01Jan2006</td>
<td>00:45</td>
<td>10.6</td>
<td>11.0</td>
<td>0.04</td>
<td>0.04</td>
</tr>
<tr>
<td>01Jan2006</td>
<td>01:00</td>
<td>10.6</td>
<td>11.0</td>
<td>0.11</td>
<td>0.11</td>
</tr>
<tr>
<td>01Jan2006</td>
<td>01:15</td>
<td>10.6</td>
<td>11.0</td>
<td>0.06</td>
<td>0.06</td>
</tr>
<tr>
<td>01Jan2006</td>
<td>01:30</td>
<td>127.4</td>
<td>130.0</td>
<td>0.19</td>
<td>0.11</td>
</tr>
<tr>
<td>01Jan2006</td>
<td>01:45</td>
<td>432.5</td>
<td>439.0</td>
<td>0.22</td>
<td>0.03</td>
</tr>
<tr>
<td>01Jan2006</td>
<td>02:00</td>
<td>522.3</td>
<td>525.0</td>
<td>0.12</td>
<td>0.03</td>
</tr>
<tr>
<td>01Jan2006</td>
<td>02:15</td>
<td>521.5</td>
<td>524.0</td>
<td>0.15</td>
<td>0.03</td>
</tr>
<tr>
<td>01Jan2006</td>
<td>02:30</td>
<td>688.0</td>
<td>693.0</td>
<td>0.22</td>
<td>0.03</td>
</tr>
<tr>
<td>01Jan2006</td>
<td>02:45</td>
<td>860.9</td>
<td>865.0</td>
<td>0.24</td>
<td>0.03</td>
</tr>
<tr>
<td>01Jan2006</td>
<td>03:00</td>
<td>1510.5</td>
<td>1524.0</td>
<td>0.59</td>
<td>0.03</td>
</tr>
<tr>
<td>01Jan2006</td>
<td>03:15</td>
<td>1449.9</td>
<td>1451.0</td>
<td>0.14</td>
<td>0.03</td>
</tr>
<tr>
<td>01Jan2006</td>
<td>03:30</td>
<td>828.8</td>
<td>827.0</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>01Jan2006</td>
<td>03:45</td>
<td>489.7</td>
<td>489.0</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>01Jan2006</td>
<td>04:00</td>
<td>350.4</td>
<td>349.0</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>01Jan2006</td>
<td>04:15</td>
<td>258.0</td>
<td>256.0</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>01Jan2006</td>
<td>04:30</td>
<td>200.0</td>
<td>199.0</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>01Jan2006</td>
<td>04:45</td>
<td>165.9</td>
<td>165.0</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>01Jan2006</td>
<td>05:00</td>
<td>134.9</td>
<td>134.0</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>01Jan2006</td>
<td>05:15</td>
<td>101.4</td>
<td>99.0</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>01Jan2006</td>
<td>05:30</td>
<td>65.5</td>
<td>63.0</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>01Jan2006</td>
<td>05:45</td>
<td>37.9</td>
<td>36.0</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>01Jan2006</td>
<td>06:00</td>
<td>22.2</td>
<td>21.0</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>01Jan2006</td>
<td>06:15</td>
<td>13.8</td>
<td>13.0</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>01Jan2006</td>
<td>06:30</td>
<td>11.0</td>
<td>11.0</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>01Jan2006</td>
<td>06:45</td>
<td>10.6</td>
<td>11.0</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>01Jan2006</td>
<td>07:00</td>
<td>10.6</td>
<td>11.0</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>01Jan2006</td>
<td>07:15</td>
<td>10.6</td>
<td>11.0</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>01Jan2006</td>
<td>07:30</td>
<td>10.6</td>
<td>11.0</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>
APPENDIX K.  
Review of Loss Method

HEC has modified the loss method options since. Also, we were told that another method besides the complicated Soil Moisture Accounting Method would provide the same results. Below are the results of a HEC-HMS run using different loss methods to determine if a different method would in fact work and how we should be using the modification in HEC-HMS to match the HYDRO6 model outputs.

Model Used
We used the HYDRO6 output results from a Baxter Creek model to compare the different of HEC-HMS loss options.

Methods
The three methods that were reviewed were:

- Soil Moisture Accounting,
- Deficit and Constant, and
- Initial and Constant methods.

A model was created with three subbasins named using the above loss method names.

After looking at the different Loss method options, it was determined that all three methods would result in the same results as HYDRO6. If the “Max Storage” value in the Surface>Simple Surface method was used for what we call the initial loss and then constant loss in HYDRO 6 was input as “Constant Loss” or the “Max Infiltration” value in the Loss Methods, all three methods gave the same result.

Below are use descriptions and partial screen shots from each of the methods used in HEC-HMS. Because it is the simplest (has fewest fields), we recommend the Initial and Constant loss method be used with the Simple Surface Surface method. Below is a summary of how to use each method with screen shots from HEC-HMS.

March 6, 2018  
Page K-1 of 3
Soil Moisture Accounting Loss Method
Use the Simple Surface option and input HYDRO6 method initial loss into the field for “Max Storage” on the Surface tab. Input the HYDRO6 constant infiltration rate into the field for “Max Infiltration”.

![Image of HEC-HMS software interface showing the Simple Surface option and input fields for max storage and max infiltration.]
**Deficit and Constant Loss Method**

Use the Simple Surface option and input HYDRO6 method initial loss into the field for “Max Storage” on the Surface tab. Input the HYDRO6 constant infiltration rate into the field for “Max Infiltration”.

---

**Initial and Constant Loss Method**

Use the Simple Surface option and input HYDRO6 method initial loss into the field for “Max Storage” on the Surface tab. Input the HYDRO6 constant infiltration rate into the field for “Max Infiltration”.

---